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Page Builder Basic

Basic Styling in Page Builder
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IT241 Web Customize New Edit Page Howdy, admin -

psum dolor sit amet, consectetur adipiscing elit. Nullam non blandit lacus. Cras nunc massa, varius vel volutpat ac, tincidunt ut Search

tristique convallis. Phasellus dolor ligula, dignissim non porttitor sit amet, feugiat a ex. Nam m

a , ac iaculis ligula blandit. Quisque odio quam, feugiat lobortis faucibus eget, pellentesque varius quam.
.

ﬂ a ﬂ < : u Sto m Ize Hignissim quam blandit a. Morbi ornare, ex et porta pharetra, justo quam bibendum dolor, non luctus ex

gue dolor id elit tincidunt, vitae bibendum leo vehicula. Pellentesque cursus congue nulla a cursus. Recent PDStS

attis eu, cursus id eros. Donec ac metus eget metus gravida interdum id et ligula.

Hello world!
Nullam ac ex odio. Aenean vulputate metus enim, eu elementum mauris volutpat suscipit. Sed urna dui, mattis luctus leo vitae, tempus
luctus lectus. Curabitur congue non neque placerat porta. Sed cursus arcu nec tempus maximus. Etiam tristique mi eget nulla
sollicitudin placerat. Recent Comments

Vivamus mattis efficitur elit, non sagittis tortor consectetur id. Vivamus sit amet ligula vulputate, rhoncus erat sed, lacinia augue. AWordPress Commenter on Hello world|

Etiam nec eros at odio commodo scelerisque.

— MrXxx Lxxx

Curabitur consectetur risus risus, sit amet auctor nulla sollicitudin a. Integer tempor accumsan cursus. Etiam ultrices sit amet libero ac
pretium. Quisque varius convallis purus, nec tristique sem eleifend eu. Suspendisse eget scelerisque lacus. Morbi elit tellus, tempus ut

ipsum eu, tempus elementum ligula.

9 0.03.9T3UN3T  sNI lTY
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You are customizing

[T241 Web

Premium Addons Available >

Active theme
OceanWP

ABENIT

Published

’131"33’ OceanWP Theme

Site Identity

Colors

Menus

Widgets

Homepage Settings

Additional CSS

Typography

General Options

Blog

Header

—_

© Hide Controls

Place your content here

IT241 Web

Home

Lorem ipsum dolor sit amet, consectetur adipiscing elit. Nullam non blandit lacus. Cras nunc massa, varius vel
volutpat ac, tincidunt ut sem. Sed convallis nisl egestas tristique convallis. Phasellus dolor ligula, dignissim non
porttitor sit amet, feugiat a ex. Nam consectetur erat id nibh gravida, ac iaculis ligula blandit. Quisque odio quam,
feugiat lobortis faucibus eget, pellentesque varius quam. Cras posuere risus lorem, non dignissim quam blandit a.
Morbi ornare, ex et porta pharetra, justo quam bibendum dolor, non luctus ex nibh eu libero. Suspendisse congue
dolor id elit tincidunt, vitae bibendum leo vehicula. Pellentesque cursus congue nulla a cursus. Vivamus odio odio,
laoreet et mattis eu, cursus id eros. Donec ac metus eget metus gravida interdum id et ligula.

Nullam ac ex odio. Aenean vulputate metus enim, eu elementum mauris volutpat suscipit. Sed urna dui, mattis
luctus leo vitae, tempus luctus lectus. Curabitur congue non neque placerat porta. Sed cursus arcu nec tempus
maximus. Etiam tristique mi eget nulla sollicitudin placerat.

Vivamus mattis efficitur elit, non sagittis tortor consectetur id. Vivamus sit amet ligula vulputate, rhoncus erat

sed, lacinia augue. Etiam nec eros at odio commodo scelerisque.

—  MrXx Lxxx

Curabitur consectetur risus risus, sit amet auctor nulla sollicitudin a. Integer tempor accumsan cursus. Etiam
ultrices sit amet libero ac pretium. Quisque varius convallis purus, nec tristique sem eleifend eu. Suspendisse eget

empus elementum ligula.

Theme Options

@ Search

@ Recent Posts

Hello world!

@ Recent Comments

A WordPress Commenter on Hello world!
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l Designing Top Bar

X Published
You are customizing (7]
IT241 Web

Premium Addons Available >

Active theme
Oceanwp

Site Identity >
Colors >
Menus ?
Widgets >
Homepage Settings >
Additional CSS >
Typography >
General Options >
Blog >
Header >
Tob Bar >
@ Hide Controls B A |

Place your content here

IT241 Web

Home

Lorem ipsum dolor sit amet, consectetur adipiscing elit. Nullam non blandit lacus. Cras nunc massa, varius vel
volutpat ac, tincidunt ut sem. Sed convallis nisl egestas tristique convallis. Phasellus dolor ligula, dignissim non
porttitor sit amet, feugiat a ex. Nam consectetur erat id nibh gravida, ac iaculis ligula blandit. Quisque odio quam,
feugiat lobortis faucibus eget, pellentesque varius quam. Cras posuere risus lorem, non dignissim quam blandit a.
Morbi ornare, ex et porta pharetra, justo quam bibendum dolor, non luctus ex nibh eu libero. Suspendisse congue
dolor id elit tincidunt, vitae bibendum leo vehicula. Pellentesque cursus congue nulla a cursus. Vivamus odio odio,

laoreet et mattis eu, cursus id eros. Donec ac metus eget metus gravida interdum id et ligula.

Nullam ac ex odio. Aenean vulputate metus enim, eu elementum mauris volutpat suscipit. Sed urna dui, mattis
luctus leo vitae, tempus luctus lectus. Curabitur congue non neque placerat porta. Sed cursus arcu nec tempus

maximus. Etiam tristique mi eget nulla sollicitudin placerat.

Vivamus mattis efficitur elit, non sagittis tortor consectetur id. Vivamus sit amet ligula vulputate, rhoncus erat

sed, lacinia augue. Etiam nec eros at odio commodo scelerisque.

— Mr.Xxx Lo

Curabitur consectetur risus risus, sit amet auctor nulla sollicitudin a. Integer tempor accumsan cursus. Etiam
ultrices sit amet libero ac pretium. Quisque varius convallis purus, nec tristique sem eleifend eu. Suspendisse eget

scelerisque lacus. Morbi elit tellus, tempus ut ipsum eu, tempus elementum ligula.

9 Search

@ Recent Posts

Hello world!

@ Recent Comments

A WordPress Commenter on Hello world!

Site Identity

Colors

Menus

Widgets

Homepage Settings

Additional CSS

Typography

General Options

Blog

Header

Top Bar

Footer Widgets

Footer Bottom

Sidebar

11
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Designing Top Bar

General

Content
A @a HTML code
‘2 RIUIIDUNTA icon e (https://fontawesome.com/)
Social
A Facebook
A Line

R, 081-1234567 & info.itsci@miju.ac.th
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l Desinging the Header >

I Colors >
General > Menus ,
. Widgets >

Header Media >
I Homepage Settings >
Logo > Additional CSS >
Typography >

Menu >
General Options >
Social Menu > Blog ?
Header >

Mobile Menu >
é Top Bar >
Footer Widgets >
Footer Bottom >
Sidebar >

Services Vv About Contact Q
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l Designing the footer

Copyright Information Technology - Designed by ITSCI

Site Identity

Colors

Menus

Widgets

Homepage Settings

Additional CSS

Typography

General Options

Blog

Header

Top Bar

Footer Widgets

Footer Bottom

Sidebar




Designing the footer

Columns

Heading Tag

H4

Copyright Information Technology - Designed by ITSCI

Site Identity

Colors

Menus

Widgets

Homepage Settings

Additional CSS

Typography

General Options

Blog

Header

Top Bar

Footer Widgets

Footer Bottom

Sidebar




l Designing the footer

Footer Widgers

. A Y
A g1nyNNNIzaNLUULDINIY Gutenberg

A 1310 Classic Widgets Plugin

Site Identity

Colors

Menus

Default Sidebar

Footer 1

Widgets

Homepage Settings

Additional CSS

Footer 2

Footer 3

Footer 4

Widgets in this area are used in the first

footer region.

= Add a Widget ’

Site Identity

Colors

Menus

Widgets

Homepage Settings

Additional CSS

Typography

General Options

Blog

Header

Top Bar

Footer Widgets

Footer Bottom

Sidebar




.

Customizing » Widgets
Footer 1

Widgets in this area are used in the first
footer region.

Search Widgets

l Designing the footer

Text: About ITSCI A
Q, text X
Title:
= Text About ITSCI

Arbitrary text.

X Add a Widget

Q7 Add media Visual == Text

B I = £ &

Nulla facilisi. Maecenas sit amet

ullamcorper in enim.

Delete | Done

Reorder =+ Add a Widget l

17
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l Designing the footer

Default Sidebar >
Footer 1 >
Footer 2 > Title:
Contact Information

Footer 3 > .
Q3 Add media Visual  Text

B I = = &

Phone
X Search Widgets
Q text -~ (+66) 0123456789
Customizing » Widgets
EMAIL

Footer 1 = Text

Arbitrary text. info.itsci@mju.ac.th

Widgets in this area are used in the first
footer region.

¥ Add a Widget

Delete | Done

Reorder <+ Add a Widget

18 0.03.9T3UN3T  sNI lTY



Designing the footer

LLNIN Facebook like box

A Hausntmasauniain “Facebook like box’

facebook like box

All  Images Shopping Videos News Maps Books : More

Facebook
https://developers.facebook.com > like-box-for-pages

Facebook Like Box - Social Plugins

The Like Box is a special version of the Like Button designed for Facebook Pages. It allows
admins to promote their Pages and embed a simple feed of...

Like Box

Le plugin Like Box est une version spéciale du bouton J'aime ...

Docs > Social Plugins > Deprecated > Like Box

Social Plugins

Comments
Embedded Posts
Embedded Videos
Group Plugin

Like Button

Page Plugin

Save Button
Share Button
oEmbed

Like Box

With the release of Grap
The Page Plugin allows y

If you did not manually U
back to the Page Plugin.

The Like Box is a special version

Pages and embed a simple feed



Designing the footer

LLNIN Facebook like box

A Hausntmasauniain “Facebook like box’

facebook like box

All  Images Shopping Videos News Maps Books : More

Facebook
https://developers.facebook.com > like-box-for-pages

Facebook Like Box - Social Plugins

The Like Box is a special version of the Like Button designed for Facebook Pages. It allows
admins to promote their Pages and embed a simple feed of...

Like Box

Le plugin Like Box est une version spéciale du bouton J'aime ...

Docs > Social Plugins > Deprecated > Like Box

Social Plugins

Comments
Embedded Posts
Embedded Videos
Group Plugin

Like Button

Page Plugin

Save Button
Share Button
oEmbed

Like Box

With the release of Grap
The Page Plugin allows y

If you did not manually U
back to the Page Plugin.

The Like Box is a special version

Pages and embed a simple feed



l Designing the footer

A n3anfiaguas Facebook

L3N Facebook like box

Facebook Page URL Tabs
https://www.facebook.com/IT.Major.MJU| timeline

Width Height
The pixel width of the embed (Min. 180 to Max. 500) The pixel height of the embed (Min. 70)

Use Small Header

_| Hide Cover Photo

v Adapt to plugin container width

v Show Friend's Faces

J#" 3 Information Technology Divi...

;.? 3,849 followers

s

E3 Follow Page &
v‘ Fad

Album n&495 wnaTuTadissaumeaiinuinns
dean In1sfinen 2567

NABINTT LT “https://www.facebook.com/IT.Major.MJU"



l Designing the footer

JavaScript SDK  |Frame

Step 1: Choose your App ID and Language

Sarachai v English (US) v

This app is in Development Mode and not available publicly.
Public Mode can be enabled in the App Dashboard.

Step 2: Include the JavaScript SDK on your page once, ideally right after the opening body tag.

<div id="fb-root'"></div>
<script async defer crossorigin="anonymous"

src="https://connect.facebook.net/en_US/sdk. js#xfbml=1&version=v20.0&appId=3841
95031703072" nonce="Z72vPoVG'"></script>

Step 3: Place this code wherever you want the plugin to appear on your page.

<div class="fb-page" data-href="https://www.facebook.com/IT.Major.MJU" data-
tabs="timeline" data-width="" data-height="" data-small-header="false" data-
adapt-container-width="true" data-hide-cover="false" data-show-facepile="true">
<blockquote cite="https://www.facebook.com/IT.Major.MJU" class="fb-xfbml-parse—-
ignore'><a href="https://www.facebook.com/IT.Major.MJU">Information Technology
Division, Faculty of Science, Maejo University</a></blockquote></div>

22 0.03.9T3UN3T  sNI lTY



Default Sidebar

Footer 1

Footer 2

Footer 3

X m Search Widgets

Q HTML X

Customizing » Widgets
Footer 3

+ CustomHTML
Arbitrary HTML code.

Widgets in this area are used in the third

> footer region.
X Add a Widget
JavaScript SDK  [Frame
Custom HTML A
Tit Step 1: Choose your App ID and Language
itle:
Sarachai v English (US) v
Content: This app is in Development Mode and not available publicly.

Public Mode can be enabled in the App Dashboard.
1 <div id="fb-root"></div>

2 <script async defer
crossorigin="anon
src="https://connect. face
book.net/en_US/sdk. js#xfb <div id="fb-root"></div>

ml=1&version=v20.0&appld= <script async defer crossorigin="anonymous"
384195031703072" src="https://connect. facebook.net/en_US/sdk. js#xfbml=1&version=v20.0&appIld=3841
95031703072" nonce="Z72vPoVG"></script>

Step 2: Include the JavaScript SDK on your page once, ideally right after the opening body tag.

nonce="Z72vPoVG">
</script>
3 Step 3: Place this code wherever you want the plugin to appear on your page.
4 <div class="fb-page"
data-

div class="fb-page" data-href="https: . facebook.com/IT.Major.MJU" data-
href="https://www.faceboo s Pag L 4 !

tabs="timeline" data-width="" data-height="" data-small-header="false" data-

k.com/IT.Major.MJU" adapt-container—-width="true" data-hide—cover="false" data-show-facepile="true">
tabs="timeline" data- <blockquote cite="https://www.facebook.com/IT.Major.MJU" class="fb-xfbml-parse-
ignore"><a href="https://www.facebook.com/IT.Major.MJU">Information Technology

Delete | Done Division, Faculty of Science, Maejo University</a></blockquote></div>

Reorder l + Add a Widget l




Background Color

Select Color

Text Color

Top Bar

Select Color

Footer Widgets > Borders Color

Select Color

Footer Bottom Links Color

Select Color

Links Color: Hover

Select Color

About ITSCI Contact Information

Information Technology Division,
Nulla facilisi. Maecenas sit amet interdum nulla. Phone . )
Facully of Science, Maejo

Morbi id augue ac libero porta imperdiet in eget S
University

lectus. Etiam dui sem, condimentum quis porttitor (+66) 0123456789

nec, ullamcorper in enim.
=

info.itsci@miju.ac.th

Copyright Information Technology - Designed by ITSCI
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l Page Builder

11991%il Page Builder IUIUNIN LK WordPress N8 &INIAIN
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Elementor Website Builder 1w Plugin Nidanufiauunniige

Elementor Website

Builder — More than
Just a Page Builder
The Elementor Website Builder
asita and drop page
ect design
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ha |- drag and drop pag
baui pixel fact d
meob ESPOr diting d
mo 1513
By o
2 Last Updated: 1 m g

10+ Million Active Installations Untested with your version of WordPress
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ARIINAAAI Elementor Website Builder a2 lAwua 616
o &
A9k

General Integrations = Adwvanced Performance Features Editor Top Bar Default »

=

Default ek of

ementor - ray. L

© e 8
B Templates Settings Experiments and Features '

| Inactive

Role Manager Persomalize your Elementor experience by contrelling which features and experiments 3

b, A =

earance

» pp Element Manager - . . .
= 0 use an experiment or feature on your site, simply click on the dropdown next to it an

Sawe Changes
Back to default

& Plugins

nstalled Plugins

Activate Al | | Dreactivate All |

Add Mew Plugin

Plugin File Editor

Users

-
o~
&

Add-ons

- @ Edit with Elementor

Upgrade




l Taw Title VaINU Page

1T241 Web Customize New Edit Page Howdy, admin .

R, 081-1234567 & info.itsci@miju.ac.th [+ ]

Services v About Contact Q

Home

Lorem ipsum dolor sit amet, consectetur adipiscing elit. Nullam non blandit lacus. Cras nunc massa, varius vel volutpat ac, tincidunt ut Search

sem. Sed convallis nisl egestas tristique convallis. Phasellus dolor ligula, dignissim non porttitor sit amet, feugiat a ex. Nam m
consectetur erat id nibh gravida, ac iaculis ligula blandit. Quisque odio quam, feugiat lobortis faucibus eget, pellentesque varius quam.

Cras posuere risus lorem, non dignissim quam blandit a. Morbi ornare, ex et porta pharetra, justo quam bibendum dolor, non luctus ex

nibh eu libero. Suspendisse congue dolor id elit tincidunt, vitae bibendum leo vehicula. Pellentesque cursus congue nulla a cursus. Recent Posts

Vivamus odio odio, laoreet et mattis eu, cursus id eros. Donec ac metus eget metus gravida interdum id et ligula.

Nullam ac ex odio. Aenean vulputate metus enim, eu elem IT241 We b Services vV About Contact Q
luctus lectus. Curabitur congue non neque placerat porta.

sollicitudin placerat.

Vivamus mattis efficitur elit, non sagittis tortor consectel

Lorem ipsum dolor sit amet, consectetur adipiscing elit. Nullam non blandit lacus. Cras nunc massa, varius vel volutpat ac, tincidunt ut Search
sem. Sed convallis nisl egestas tristique convallis. Phasellus dolor ligula, dignissim non porttitor sit amet, feugiat a ex. Nam m
consectetur erat id nibh gravida, ac iaculis ligula blandit. Quisque odio quam, feugiat lobortis faucibus eget, pellentesque varius quam.

Etiam nec eros at odio commodo scelerisque.

Cras posuere risus lorem, non dignissim quam blandit a. Morbi ornare, ex et porta pharetra, justo quam bibendum dolor, non luctus ex
nibh eu libero. Suspendisse congue dolor id elit tincidunt, vitae bibendum leo vehicula. Pellentesque cursus congue nulla a cursus. Recent Posts
Vivamus odio odio, laoreet et mattis eu, cursus id eros. Donec ac metus eget metus gravida interdum id et ligula.

Hello world!

Nullam ac ex odio. Aenean vulputate metus enim, eu elementum mauris volutpat suscipit. Sed urna dui, mattis luctus leo vitae, tempus

30 0.03.9T3UN3T  sNI lTY



RAIINNAAFI OceanWP

aziingniinaali@aeas Ocean Extra

Awesome Possum - You're Amazing!

Thank you for updating to OceanWP v3.5.9!

*  Thank you for installing the OceanWP theme.

We have introduced this opt-in so you never miss an important
We highly recommend you to install and activate the Ocean Extra plugin. update and help us make the theme more compatible with
This plugin will unlock new power tools to help you build an amazing website. Get access1  Your site and better at doing what you need it to.

Opt in to get email notifications for security & feature updates,
educational content, and occasional offers, and to share some
basic WordPress environment info. If you skip this, that's okay!
Metabox settings to control pages and posts individually, OceanWP will still work just fine.

» freemium website template demos,

» WordPress widgets,

ability to create and use custom templates,

and much, much more. Allow & Continue =
Install & Activate Ocean Extra This will allow OceanWP to =

31 0.03.9T3UN3T  sNI lTY
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Lorem ipsum dolor sit amet, consectetur adipiscing elit. Nullam non blandit lacus. Cras nunc massa, varius vel volutpat ac, tincidunt ut Search

sem. Sed convallis nisl egestas tristique convallis. Phasellus dolor ligula, dignissim non porttitor sit amet, feugiat a ex. Nam m
consectetur erat id nibh gravida, ac iaculis ligula blandit. Quisque odio quam, feugiat lobortis faucibus eget, pellentesque varius quam.
Cras posuere risus lorem, non dignissim quam blandit a. Morbi ornare, ex et porta pharetra, justo quam bibendum dolor, non luctus ex
nibh eu libero. Suspendisse congue dolor id elit tincidunt, vitae bibendum leo vehicula. Pellentesque cursus congue nulla a cursus. Recent Posts
Vivamus odio odio, laoreet et mattis eu, cursus id eros. Donec ac metus eget metus gravida interdum id et ligula.
Hello world!
Nullam ac ex odio. Aenean vulputate metus enim, eu elementum mauris volutpat suscipit. Sed urna dui, mattis luctus leo vitae, tempus

Page Settings & Styling * BB
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Lorem ipsum dolor sit amet, consectetur adipiscing elit. Nullam non blandit lacus. Cras nunc massa, varius vel volutpat ac, tincidunt ut sem. Sed convallis nisl egestas tristique convallis. Phasellus dolor ligula, dignissim non porttitor sit
E Ge n eral Fa amet, feugiat a ex. Nam consectetur erat id nibh gravida, ac iaculis ligula blandit. Quisque odio quam, feugiat lobortis faucibus eget, pellentesque varius quam. Cras posuere risus lorem, non dignissim quam blandit a. Morbi ornare,
ex et porta pharetra, justo quam bibendum dolor, non luctus ex nibh eu libero. Suspendisse congue dolor id elit tincidunt, vitae bib leo vehicula. P cursus congue nulla a cursus. Vivamus odio odio, laoreet et mattis

eu, cursus id eros. Donec ac metus eget metus gravida interdum id et ligula.

Nullam ac ex odio. Aenean vulputate metus enim, eu elementum mauris volutpat suscipit. Sed urna dui, mattis luctus leo vitae, tempus luctus lectus. Curabitur congue non neque placerat porta. Sed cursus arcu nec tempus maximus.

CO nte nt Layo ut Etiam tristique mi eget nulla sollicitudin placerat.

Vivamus mattis efficitur elit, non sagittis tortor consectetur id. Vivamus sit amet ligula vulputate, rhoncus erat sed, lacinia augue. Etiam nec eros at odio commodo scelerisque.

v Default
Right Sidebar

Left S | d e ba r scelerisque lacus. Morbi elit tellus, tempus ut ipsum eu, tempus elementum ligula.

= MrXoox Lo

Curabitur consectetur risus risus, sit amet auctor nulla sollicitudin a. Integer tempor accumsan cursus. Etiam ultrices sit amet libero ac pretium. Quisque varius convallis purus, nec tristique sem eleifend eu. Suspendisse eget

Full Width
100% Full Width
Both Sidebars
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v Layout

Container

v Basic

T

Heading

Text Editor

Button

+ X
Lorem ipsum dolor sit amet, consectetur adipiscing elit. Nullam non blandit lacus. Cras nunc massa, varius £
volutpat ac, tincidunt ut sem. Sed convallis nisl egestas tristique convallis. Phasellus dolor ligula, dignissim
non porttitor sit amet, feugiat a ex. Nam consectetur erat id nibh gravida, ac iaculis ligula blandit. Quisque odio
quam, feugiat lobortis faucibus eget, pellentesque varius quam. Cras posuere risus lorem, non dignissim quam
blandit a. Morbi ornare, ex et porta pharetra, justo quam bibendum dolor, non luctus ex nibh eu libero.
Suspendisse congue dolor id elit tincidunt, vitae bibendum leo vehicula. Pellentesque cursus congue nulla a
cursus. Vivamus odio odio, laoreet et mattis eu, cursus id eros. Donec ac metus eget metus gravida interdum

id et ligula

Nullam ac ex odio. Aenean vulputate metus enim, eu elementum mauris volutpat suscipit. Sed urna dui, mattis
luctus leo vitae, tempus luctus lectus. Curabitur congue non neque placerat porta. Sed cursus arcu nec tempus

maximus. Etiam tristique mi eget nulla sollicitudin placerat.

Vivamus mattis efficitur elit, non sagittis tortor consectetur id. Vivamus sit amet ligula vulputate, rhoncus erat

sed, lacinia augue. Etiam nec eros at odio commodo scelerisque.

+ W

Drag widget here



Elementor Website Builder

v Layout
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v Basic

Heading

Text Editor

Divider

A

Add Your Heading Text Here

Lorem ipsum dolor sit amet, consectetur adipiscing elit. Ut elit tellus, luctus nec ullamcorper mattis, pulvinar dapibus leo.
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Counter

Shortcode
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Read More
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Add Your Heading Text Here
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Edit Container i
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O ¢ Lorem ipsum dolor sit amet, consectetur adipiscing elit. Ut elit tellus, luctus nec ullamcorper mattis, pulvinar dapibus leo.

Style Advanced
Lorem ipsum dolor sit amet, consectetur adipiscing elit. Ut elit tellus, luctus nec ullamcorper mattis, pulvinar dapibus leo.

Lorem ipsum dolor sit amet, consectetur adipiscing elit. Ut elit tellus, luctus nec ullamcorper mattis, pulvinar dapibus leo.
v Container

Lorem ipsum dolor sit amet, consectetur adipiscing elit. Ut elit tellus, luctus nec ullamcorper mattis, pulvinar dapibus leo.

w

Container Layout Flexbox

Content Width

Width I
®

Min Height 3

Vertical

(Column)
ltems

Direction & Desktop = |

Justify Content 3

Align tems &

Gaps
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Edit Container

| am a Heading Lorem ipsum dolor sit amet, consectetur adipiscing elit. Ut elit tellus, luctus nec ullamcorper mattis, pulvinar dapibus leo.

@ L)) &

Lorem ipsum dolor sit amet, consectetur adipiscing elit. Ut elit tellus, luctus nec ullamcorper mattis, pulvinar dapibus leo.
Layout Style Advanced

Lorem ipsum dolor sit amet, consectetur adipiscing elit. Ut elit tellus, luctus nec ullamcorper mattis, pulvinar dapibus leo.

+ Container
Lorem ipsum dolor sit amet, consectetur adipiscing elit. Ut elit tellus, luctus nec ullamcorper mattis, pulvinar dapibus leo.

Container Layout Flexbox

Content Width Boxed

Width O

N Horizontal (Row)
in Height G

Items
Direction &

Justify Content &

Align ltems &
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Justify Content
Background Color
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Background Overlay
Margin & Padding
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Lorem ipsum dolor sit amet, consectetur adipiscing elit. Ut elit tellus, luctus nec ullamcorper mattis, pulvinar dapibus leo.
Lorem ipsum dolor sit amet, consectetur adipiscing elit. Ut elit tellus, luctus nec ullamcorper mattis, pulvinar dapibus leo.
Lorem ipsum dolor sit amet, consectetur adipiscing elit. Ut elit tellus, luctus nec ullamcorper mattis, pulvinar dapibus leo.

Lorem ipsum dolor sit amet, consectetur adipiscing elit. Ut elit tellus, luctus nec ullamcorper mattis, pulvinar dapibus leo.

w
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Container Layout Flexbox

Min Height 3 pX v

() 268

To achieve full height Container use 100vh.

Lorem ipsum dolor sit amet, consectetur adipiscing elit. Ut elit tellus, luctus nec ullamcorper mattis, pulvinar dapibus leo.

Lorem ipsum dolor sit amet, consectetur adipiscing elit. Ut elit tellus, luctus nec ullamcorper mattis, pulvinar dapibus leo.
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Content Width Boxed

Width O
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() 268

To achieve full height Container use 100vh.
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Bam a Heading

ipsum dolor sit amet, consectetur adipiscing elit. Ut elit te

psum dolor sit amet, consectetur adipiscing elit. Ut elit tellli§; luctus nec ullamcorper mattis;

Click here

55 0.03.9T3UN3T  sNI lTY



l Container Basic Styles

Edit Container

@ )

Layout

» Background

v Background Overlay

Normal
Background Type

Color

Image &

Opacity &

CSS Filters

#000000B0
Blend Mode
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Lorem ipsum dg or sit amet, consectetur adipiscing elit. Ut elit tellus, luctus nec ullamcorper mattis, pulvinar dapibus leo.

Lorem ipsum dg or sit amet, consectetur adipiscing elit. Ut elit tellus, luctus nec ullamcorper mattis, pulvinar dapibus leo.
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Lorem ipsum dolor sit amet, consectetur adipiscing elit- Ut elit tellus, luctus nec ullamcorper mattis, pulvinar dapibus leo.

Lorem ipsum dolor sit amet, consectetur adipiscing elit. Ut elit tellus, luctus nec ullamcorper mattis, pulvinar dapibus leo.

58

Services v

About

Contact Q

0.03.9T3UN3T  sNI lTY



l Margin and Spacing

margin
border
padding

content

TRIINIZHIN element PAITNTLRINL BRI ULF UYL

element 2.01.IT3UNT &I LY



Margin and Spacing

v Border

Normal

Border Type

Border Width &

12 5 12 12

Bottom

Add Your Heading Text Here




Edit Heading

4

Content

v Layout

Margin 3

13 13

Top Right
Padding O3

49 49

)

13

Bottom

49

Bottom

Margin and Spacing

>

Advanced

Add Your Heading Text Here




v Layout

Margin Q3

Padding &

Align Self

Add Your Heading Text Here
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